
Appendix D: General Device Interface Certification Procedure 
1.  (Local Mode Only)  

D.1 Scope 
 
This test plan verifies all of the general screen-based portions of the automated tracking 
station graphical user interface (GUI) software.  This test plan addresses only the local 
modes, therefore the GUI is to be tested in only the following control modes: Local Edit 
and Local Control/Monitor.    
 

D.2 Environment 
 
• Pentium processor or better 
• Minimum 16 megabytes RAM 
• Windows NT 4.0 
• Hardware device to be tested 
 

D.3 Resources 
 
The following files need to reside in the same directory: 
 
• Application executable (DeviceSomething.exe) 
• Initialization file defined by APP_INIT_FILE in DeviceSomething. h 
(DeviceSomething.ini) 
• Device configuration file defined by APP_CONFIG_FILE in DeviceSomething. h 
(DeviceSomething.something) 
• Default device configuration file defined by APP_DEFAULT_FILE in DeviceSomething. h 
(DeviceSomethingDefault.something) 
• Informational file defined by APP_UPDATE_FILE in DeviceSomething. h 
(DeviceSomething.txt) 
• File defined by DEVICE_HARDWARE_SPECS_FILE in DeviceSomething. h 
(SomethingHardwareSpecs.txt) 
• Device status update file WcDevDeviceMakeModel.status 
• Application help file (DeviceSomething.hlp) 
 
The following files are also required: 
 
• Support dynamic link libraries (DeviceMakeModel.dll) 
• Applicable MFC dll’s (i.e. mfc42u.dll), MSVC dll’s (i.e. msvcrt40.dll) 
 

D.4 Assumptions 
 



• The tester is knowledgeable in the basics of Windows program operation including 
features such as pull-down menus, toolbars, and “drag and drop”.  
• The GUI has been installed on the test computer. 
• The device to be tested has been setup and correctly connected to the computer. 



 

D.5 Procedures 
 
All menu items and toolbars will be tested in each applicable mode. Response of the 
device in Local/Control and Remote Control modes will be verified to the extent possible 
for the particular device.  Any data calculations made, as part of the data entry, will be 
validated.   
 
A checklist will be provided for every item of each mode to facilitate testing.  Check the 
box for each item that passes. If any item fails, add a comment to the Comments Table at 
the end of this document. The comment should cross reference the item number that 
failed and give details about why the item failed the test.  
 
The tester may also add any other comments to the comments table. If the comments 
pertain to a particular item then cross reference with the item number.



Checklist 
 
A check box precedes each of the following procedures.  This check box is to be checked 
if and only if the test passes; i.e. the statement is true. 
 

D.6.1.0 Local Edit 
 

q  1.1.0 The application initializes by double clicking on appropriate icon without any errors.   No 
command line arguments expected. 

 
q  1.2.0 The following menu options are available before a file is open: File, View and Help.  

 
q  1.2.1 The following File pull-down menu options are available: New, Open, Print Setup and 

Exit. 
 

q  1.2.1.1 Choose Print Setup.  Visually inspect print options in the standard Microsoft 
Print Setup window.  

 
q  1.2.1.1.1 Click on Cancel. 

 
q  1.2.2 The following View pull-down menu options are available: Toolbar and Status Bar. 

 
q  1.2.2.1 Choose Toolbar (which is checked).  Hides toolbar:  

     
Toolbar 

 
q  1.2.2.1.1 Choose Toolbar again.  Displays toolbar. 

 
q  1.2.2.2 Choose Status Bar (which is checked).  Hides status bar: 

 

 
Status Bar 

 
q  1.2.2.2.1 Choose Status Bar again.  Displays status bar. 

 
q  1.2.3 The following Help pull-down menu options are available: Contents, Using Help, 

About…  and Device Hardware Specifications. 
 

q  1.2.3.1 Choose Contents.  Opens device specific on-line help file. 
 

q  1.2.3.1.1 Choose Exit from the File menu or standard Microsoft close (X) button in 
the upper right-hand corner of the Help window. 

 
q  1.2.3.2 Choose Using Help.  Opens general Microsoft on-line help file. 

 
q  1.2.3.2.1 Click on Cancel or standard Microsoft close (X) button in the upper right-

hand corner of the Help Topics: Windows Help window. 
 

q  1.2.3.3 Choose About.  Displays window containing application icon, application name, 
version number and last modification date. 



 
q  1.2.3.3.1 Choose What’s New. Displays text file in Notepad.  Text file describes 

application and its recent modifications. 
 

q  1.2.3.3.1.1 Choose Exit from the File menu or standard Microsoft close (X) 
button in the upper right-hand corner of the Notepad window. 

 
q  1.2.3.4 Choose Device Hardware Specifications. Displays informational text file in 

Notepad. 
 

q  1.2.3.4.1 Choose Exit from the File menu or standard Microsoft close (X) button in 
the upper right-hand corner of the Notepad window. 

 
q  1.3.0 The following tool buttons are available: New, Open, Print Setup, Toggle ToolBar, Toggle 

StatusBar, About, Device Specifications (the last button below is an example).  

 
Tool buttons 

 
q  1.3.1 Each tool button has appropriate Tool Tip displayed when cursor is positioned over 

button. 
 

q  1.3.2 Click on Print Setup.  Visually inspect print options in the standard Microsoft Print 
Setup window.  

 
Print Setuptool button 

 

q  1.3.2.1 Click on Cancel. 
 

q  1.3.3 Toggle ToolBar – Click on ToolBar button.  Hides toolbar.  

 
Toggle ToolBar tool button 

 
q  1.3.3.1 Choose Toolbar from the View menu.  Displays toolbar. 

 
q  1.3.4 Toggle StatusBar – Click on StatusBar button.  Hides status bar. 

 
Toggle StatusBar tool button 

 
q  1.3.4.1 Choose StatusBar from the View menu.  Displays status bar. 

 
q  1.3.5 Click on About.  Displays window containing application icon, application name, 

version number and last modification date. 

 
About tool button 

 
q  1.3.6 Click on Device Specifications.  Displays informational text file in Notepad. (The 

button below is an example.) 



 
Device Specifications tool button  

 
        1.4.0 Open a new file without error by choosing the following menu option:  

 
q  1.4.1 New – A set of windows displays containing default parameters for the devi ce.   

 
q  1.4.1.1 When the standard Microsoft close (X) button in upper right -hand corner of each 

of these windows is clicked, the window does not close, but is minimized.  
 

q  1.4.1.2 For each window closed in the above step, restore it to the open state by double-
clicking on the title bar or clicking on the first of three buttons on the right -hand side of 
the title bar of the minimized window.  

 
q  1.4.1.3 Move a few windows by right-clicking on the title bar of the window holding the 

mouse down and dragging it.  Do  not restore window position. 
 

q  1.4.1.4 Resize a few windows by positioning the cursor over an edge of the window, 
right–clicking on the mouse, holding it down and dragging it.  Do not restore window 
size.  

 
q  The following File options are now among those available after a file is open: Print and Print 

Preview. 
 

q  1.4.2 Choose Print Preview.  Displays current GUI parameters/settings in a standard text 
viewer.  

 
q  1.4.2.1 Click on  Close. 

 
q  1.4.3 Choose Print.  Displays the standard Microsoft Print window, which all ows user to 

make print choices.  
 

q  1.4.3.1 Click on  OK.  Prints parameters currently displayed in GUI.  
 

q  1.5.0 The following Window menu options are available after a file is open: Cascade, Tile, 
Arrange Icons, Window #1 (i.e. Settings), Window #2, #3, etc. (i.e. Control, Status).  The 
number of “Windows” should coincide with the number of windows open not including the main 
window of the application itself.   

 
Note:  Minimize the “bottom” window for the next two steps.  
  

q  1.5.1 Choose Cascade – Arranges windows not minimized in cascading pattern within GUI.  
 

q  1.5.2 Choose Tile – Arranges windows not minimized in tiled pattern within GUI.  
 

Note:  Minimize another window for the next step.  Move the minimized windows to different 
locations by right -clicking on the  title bars, holding the mouse down and dragging each.  

 
q  1.5.3 Choose Arrange Icons – Arranges windows minimized on bottom of GUI.   

 
Note: Open all minimized windows and choose Cascade. 

 
q  1.5.4 Choose Window #1 (i.e. Settings), if applicable: ______________ _________  (write 

window name) – Brings window #1 to foreground or “on top” of others. 
 



q  1.5.5 Choose Window #2 (i.e. Control), if applicable: _______________________  (write 
window name) – Brings window #2 to foreground or “on top” of others. 

 
q  1.5.6 Choose Window #3 (i.e. Status), if applicable: _______________________  (write 

window name) – Brings window #3 to foreground or “on top” of others. 
 

q  1.5.7 Choose Window #4, if applicable: _______________________  (write window name) – 
Brings window #4 to foreground or “on top” of others. 

 
q  1.5.8 Choose Window #5, if applicable: _______________________  (write window name) – 

Brings window #5 to foreground or “on top” of others. 
 

q  1.5.9 Choose Window #6, if applicable: _______________________  (write window name) – 
Brings window #6 to foreground or “on top” of others. 

 
q  1.5.10 Choose Window #7, if applicable: _______________________  (write window name) 

– Brings window #7 to foreground or “on top” of others. 
 

1.6.0 Specific controls – For specific functionality that sh ould be provided in a particular GUI, see the 
requirements document  for the specific device being controlled.  In some cases, controls are dependent on 
other controls; i.e. controls may not be enabled until another control is chosen.  Again, see the requir ements 
document. The following are the possible controls available, and in general, should operate in the 
following manner by clicking the mouse on them:  
 
Note:  You may need to maximize each window and/or the main application window or use the scroll 
bar(s) in order to view all of the controls.  Choose the second (middle) button in the right -hand side of the 
title bar of the window. 

 
q  1.6.1 Apply Now (if applicable) – In the Settings, Control  or similar window(s) this 

pushbutton is disabled/grayed.  

 
                        Disabled Apply Now button 

 
 

q  1.6.1a Load New (if applicable) – In the Control  or similar window(s) this pushbutton is 
disabled/grayed.  

 
 
 
 
 

                        Disabled  Load New Button 
 

 
q  1.6.2 Reset (if applicable) – In the Settings, Control or similar window(s) this pushbutton is 

disabled/grayed.  

 
                          Disabled Reset button 

 
q  1.6.3 Switch (if applicable) – In the Settings, Control  or similar window(s) this button is 

disabled/grayed:  

   
                      Disabled Switch 

 

Load New 



q  1.6.4 Edit box (if applicable) – In the Settings, Control  or similar window(s) this control is  
q  enabled unless it is dependent on another selection.  

 
Edit box 

 
q  1.6.4.1 Spin (Up/down) control (if applicable)  – Used with some edit boxes, this control 

is enabled with its associated edit box.  

 
Spin control  

 
q  1.6.4.1.1 When the up-arrow portion of the spin control is clicked the parameter in 

the associated edit box increments.  To change the digit incrementing, highlight the 
digit and click the l eft mouse button. 

 
q  1.6.4.1.2 When the down-arrow portion of the spin control is clicked the parameter 

in the associated edit box decrements. To change the digit decrementing, highlight 
the digit and click the left mouse button.  

 
q  1.6.5. Radio buttons (if applicable) – In the Settings, Control  or similar window(s) these 

controls are enabled unless it is dependent on another selection.  
 

 
Radio button group  

 
q  1.6.5.1 When a radio button is selected/clicked, the other radio buttons in that group are 

de-selected. 
 

q  1.6.6 Check box (if applicable) – In the Settings, Control  or similar window(s) this control is 
enabled unless it is dependent on another selection.  

 

 
Check box 

 
q  1.6.7 Combo box (if applicable) – In the Settings, Control  or similar window(s) this contr ol 

is enabled unless it is dependent on another selection.  
 

 
Combo box 

 
q  1.6.7.1 Click on down-arrow and the combo box should open with a selectable list:  

 



 
Open Combo box 

 
Note: In general, the user should not be able to type data into a combo box.  

 
q  1.6.8 Keyboard control  – Use the Tab key to change control selection in the Settings, 

Control  or similar window(s).  Selections should change in a general top -to-bottom, left-to-
right pattern.  

 
q  1.6.9 Status (if applicable) – In the Status window(s) parameters do not update/change. 

 
q  1.6.10 Status light  (if applicable) – In the Status, Control or similar window(s) this bitmap is 

gray: 

 
Disabled Status Light 

 
q  1.7.0 The following tool buttons are among those available after a file is open: Print, Print 

Preview, Cascade, Tile, Window #1 (i.e. Settings), Window #2, #3, etc. (i.e. Control, Status). 

 
Tool buttons  

 
q  1.7.1 Each tool button has an appropriate Tool Tip displayed when cursor is positioned over 

button: Print Preview, Print, Cascade, Tile, Window #1 (i.e. Settings), Window #2, #3, etc. 
(i.e. Control, Status) 

 
q  1.7.2 Click on Print Preview – Displays current GUI parameters/settings in a standard text 

viewer. 

 
Print Preview tool button 

q  1.7.2.1 Click on Close. 
 

q  1.7.3 Click on Print – Displays standard Microsoft Print window, which allows user to make 
print choices.  

 
Print tool button   

q  1.7.3.1 Click on Cancel. 
 

Note: Minimize one window and move and resize a few of the open windows for the next steps.  
 

q  1.7.4 Click on Cascade – Arranges windows not minimized  in cascading pattern within GUI.  

 
Cascade tool button 

 
q  1.7.5 Click on Tile – Arranges windows not minimized in tiled pattern within GUI.  

 
Tile tool button 

 



Note: Open all minimized windows and choose Cascade for the next steps. 
 

q  1.7.6 Click on Window #1 (i.e. Settings), if applicable: _______________________  (write 
window name) – Brings window #1 to foreground or “on top” of others. 

 
Settings tool button  

 
q  1.7.7 Click on Window #2 (i.e. Control), if applicable: _______________________  (write 

window name) – Brings window #2 to foreground or “on top” of others. 

 
Control tool button  

 
q  1.7.8 Click on Window #3 (i.e.  Status), if applicable: _______________________  (write 

window name) – Brings window #3 to foreground or “on top” of others. 

 
Status tool button 

 
q  1.7.9 Click on Window #4, if applicable: _______________________  (write window name) 

– Brings window #4 to foreground or “on top” of others. 
 

q  1.7.10 Click on Window #5, if applicable: _______________________ (write window name) 
– Brings window #5 to foreground or “on top” of others. 

 
q  1.7.11 Click on Window #6, if applicable: _______________________ (write window name) 

– Brings window #6 to foreground or “on top” of others. 
 

q  1.7.12 Click on Window #7, if applicable: _______________________  (write windo w name) 
– Brings window #7 to foreground or “on top” of others. 

 
q  1.8.0 The following File options are among those available after a file is open: Save and Save As. 
 

q  1.8.1 Save – Make a change to one of the parameters in the Settings (or similar) window and  
make a note of that change below.  Choose Save.  User will be prompted to save file to a new 
name in a SaveAs dialog box since the file was opened as New.  

 
Parameter: _______________________  Changed to: _______________________ 

 
q  1.8.1.1 Click on  Cancel. 

 
q  1.8.2 Choose Save As – Save a new local configuration file by entering “ Test” in dialog 

displayed. The file extension (i.e. *. bsz) will automatically be added to the name of the file.  
 

q  1.8.2.1 Click on Save. 
 

q  1.8.2.2 If message asks to overwrite an existing file, answer Yes. 
 
q  1.9.0 The following File option is now among those available after a file is open: Close. 
 

q  1.9.1 Choose Close – Closes open file.  User may be asked to save open or new file (see 
above). 

 



q  1.10.0 The following File option is now among those available: Open. 
 

q  1.10.1 Choose Open – Opens local configuration file.  Choose “Test.xxx” (i.e. Test.bsz) from 
window.  You may have to scroll until the file is visible.  The same set of windows displays as 
when a new file was open in step 1.4.1 (New). 

  
q  1.10.1.1 Check parameter changed in step 1.8.1 (Save) and make sure it is what was 

saved. 
 
q  1.11.0 The following tool buttons are now among those available: Save and Save As. 

 
q  1.11.1 Save – Make a change to another parameter (different from step 1.8.1) in Settings (or 

similar) window and make a note of that change.  
 

Parameter: _______________________  Changed to: _______________________ 
 
q  1.11.1.1 Click on Save tool button to save file. 

 
Save tool button 

 
q  1.11.1.1.1 If message asks to overwrite an existing file, answer Yes. 

 
q  1.11.2 Click on Open tool button. 

 
Open tool button  

q  1.11.3  Repeat step 1.10.1.1. 
 
q  1.12.0 The following tool button is now among those available: Close. 

 
Close tool button  

 
q  1.12.1 Click on  Close – Closes open file.  User may be asked to save open or new file (see 

step 1.8.2.1). 
 

q  1.12.1.1 If message asks to overwrite an existing file, answer Yes. 
 
q  1.13.0 The following menu option is available: Exit. 
 

q  1.13.1 Choose Exit – Terminates application.  User may be asked to save open or ne w file 
(see step 1.8.2.1), answer No. 

 
Note: At this point, the GUI has been completely checked in Local Edit.  
 

D.7.2.0 Local Control/Monitor  
 

Note: Before proceeding with this section, locate the device being controlled by the 
GUI and make sure it is on.  
 



q  2.1.0 The application initializes by  double clicking on appropriate icon without 
any errors. (The command line arguments are already provided in the icon’s 
properties.) 

 
q  2.2.0 The following menu options are available: File, View, Window, and Help.  

 
q  2.2.1 The following File pull-down menu options are among those available: Print Preview, 

Print, Print Setup and Exit. 
 

q  2.2.1.1 Print Preview – Displays parameters currently in GUI in a text viewer.  
 

q  2.2.1.1.1 Click on  Close. 
 

q  2.2.1.2 Print Setup – Visually in spect print options in the standard Microsoft Print 
Setup window. 

 
q  2.2.1.2.1 Click on  Cancel. 

 
q  2.2.1.3 Print – Displays the standard Microsoft Print window, which allows user to 

make print choices.  
 

q  2.2.1.3.1 Click on  OK – Prints parameters currently displ ayed in GUI. 
 

q  2.2.2 The following View pull-down menu options are available: Toolbar and Status Bar. 
 

q  2.2.2.1 Toolbar – Choose Toolbar (which is checked).  Hides toolbar.  
    

 
Toolbar 

 
q  2.2.2.1.1 Choose Toolbar again.  Displays toolbar.  

 
 

q  2.2.2.2 Status Bar – Choose StatusBar (which is checked).  Hides status bar.  

 
Status Bar 

 
q  2.2.2.2.1 Choose StatusBar again.  Displays status bar.  

 
q  2.2.3 A set of windows is displayed containing parameters from the device.  This can be 

verified by checking the front panel of the device with those in the GUI.   
 

q  2.2.3.1 When the standard Microsoft close (X) button in upper right -hand corner of each 
of these windows is clicked, the window does not close, but is minimized.  

 
q  2.2.3.2 For each window closed in the above step, restore it to the open state by double-

clicking on the title bar or clicking on the first of three buttons on the right -hand side of 
the title bar of the minimized window.  

 
q  2.2.3.3 Move a few windows by right-clicking on the title bar of the window holding th e 

mouse down and dragging it.  Do not restore window position. 
 



q  2.2.3.4 Resize a few windows by positioning the cursor over an edge of the window, 
right–clicking on the mouse, holding it down and dragging it.  Do not restore window 
size.  

 
q  2.2.4 The following Window pull-down menu options are available: Cascade, Tile, Arrange 

Icons, Window #1 (i.e. Settings), Window #2, #3, etc. (i.e. Control, Status) 
 

Note:  Minimize the “bottom” window for the next two steps.  
 

q  2.2.4.1 Cascade – Arranges windows not minimi zed in cascading pattern within GUI.  
 

q  2.2.4.2 Tile – Arranges windows not minimized in tiled pattern within GUI.  
 

Note:  Minimize another window for the next step.  Move the minimized windows to 
different locations by right -clicking on the title bars, hold ing the mouse down and dragging 
each. 

 
q  2.2.4.3 Arrange Icons – Arranges windows minimized on bottom of GUI.  

 
Note: Open all minimized windows and choose Cascade for the next steps. 

 
q  2.2.4.4 Window #1 (i.e. Settings), if applicable: _______________________  (write 

window name) – Brings window #1 to foreground or “on top” of others. 
 

q  2.2.4.5 Window #2 (i.e. Control), if applicable: _______________________  (write 
window name) – Brings window #2 to foreground or “on top” of others. 

 
q  2.2.4.6 Window #3 (i.e. Status), if applicable: _______________________  (write 

window name) – Brings window #3 to foreground or “on top” of others. 
 

q  2.2.4.7 Window #4, if applicable: _______________________  (write window name) – 
Brings window #4 to foreground or “on top” of others. 

 
q  2.2.4.8 Window #5, if applicable: ______________________  (write window name) – 

Brings window #5 to foreground or “on top” of others. 
 

q  2.2.4.9 Window #6, if applicable: _______________________  (write window name) – 
Brings window #6 to foreground or “on top” of others. 

 
q  2.2.4.10 Window #7, if applicable: _______________________  (write window name) – 

Brings window #7 to foreground or “on top” of others. 
 

q  2.2.5 The following Help pull-down menu options are available: Contents, Using Help, 
About…  and Device Specifications. 

 
q  2.2.5.1 Contents – Opens device specific on-line help file.  

 
q  2.2.5.1.1 Exit from the File menu or standard Microsoft close (X) button in the upper 

right-hand corner of the Help window 
 

q  2.2.5.2 Using Help – Opens general on -line help file . 
 

q  2.2.5.2.1 Click on  Cancel or standard Microsoft close (X) button in the upper right -
hand corner of the Help Topics: Windows Help window. 

 



q  2.2.5.3 About – Displays informational dialog box containing application icon, 
application name, version number and  last modification date.  

 
q  2.2.5.3.1 What’s New – Displays informational text file in Notepad.  Text file 

should describe application and its recent modifications.  
 

q  2.2.5.3.1.1 Exit from the File menu or standard Microsoft close (X) button in the 
upper righ t-hand corner of the Notepad window. 

 
q  2.2.5.4 Device Hardware Specifications – Displays informational text file in Notepad. 

 
q  2.2.5.4.1 Exit from the File menu or standard Microsoft close (X) button in the 

upper right-hand corner of the Notepad window. 
 

q  2.3.0 The following tool buttons are among those available: Print Preview, Print, Cascade, Tile, 
Window #1 (i.e. Settings), Window #2, #3, etc. (i.e. Control, Status), Device Specifications.  
The last button below is an example and there will be only one for each GUI.  The number 
represents which device is being controlled.  

 
Tool buttons  

 
q  2.3.1 Each tool button has an appropriate Tool Tip displayed when cursor is positioned over 

button: Print Preview, Print, Cascade, Tile, Window #1 (i.e. Settings), Window #2, #3, etc. 
(i.e. Control, Status) 

 
q  2.3.2 Print Preview – Displays open file in a text viewer as currently displayed in graphical 

user interface (GUI).  

 
Print Preview tool button 

 
q  2.3.2.1 Click on Close. 

 
q  2.3.3 Print – Prints open file by making c hoices in displayed a dialog.  

 
Print tool button  

 
q  2.3.3.1 Click on Cancel. 

 
Note: Minimize one window and move and resize a few of the open windows for the next steps.  

 
q  2.3.4 Cascade – Arranges windows not minimized in cascading pattern within GUI.  

 
Cascade tool button 

 
q  2.3.5 Tile – Arranges windows not minimized in tiled pattern within GUI.  

 

 
Tile tool button 

 
Note: Open all minimized windows and choose Cascade for the next steps. 



 
q  2.3.6 Window #1 (i.e. Settings), if applicable: _______________________  (write window 

name) – Brings window #1 to foreground or “on top” of others. 

 
Settings tool button   

 
q  2.3.7 Window #2 (i.e. Control), if applicable: ______________________  (write window 

name) – Brings window #2 to foreground or “on top” of others. 

 
Control tool button 

 
q  2.3.8 Window #3 (i.e. Status), if applicable: _______________________  (write window 

name) – Brings window #3 to foreground or “on top” of others. 

 
Status tool button 

 
q  2.3.9 Window #4, if applicable: _______________________  (write window n ame) – Brings 

window #4 to foreground or “on top” of others. 
 

q  2.3.10 Window #5, if applicable: _______________________  (write window name) – Brings 
window #5 to foreground or “on top” of others. 

 
q  2.3.11 Window #6, if applicable: _______________________  ( write window name) – Brings 

window #6 to foreground or “on top” of others. 
 

q  2.3.12 Window #7, if applicable: _______________________  (write window name) – Brings 
window #7 to foreground or “on top” of others. 

 
q  2.3.13 Device Specifications – Displays infor mational text file in a text viewer. (The button 

below is an example.)  

                                                                                           
                                                                                           Device Specifications tool button  
 
2.4.0 Specific controls – For specific functionality that should be provided in a particular GUI, see the 
requirements document for the specific device being controlled.  In some cases, controls are dependent on 
other controls; i.e. controls may not be enabled until another control is chosen.  Again, see the requirements 
document. The following are the possible controls available, and in general, should operate in the 
following manner by clicking the mouse on them:  
 

Note: Make sure the status bar is displayed (see steps 2.2.2.2 and 2.2.2.2.1). 
 

q  2.4.1 Apply Now (if applicable) – In the Settings, Control  or similar window(s) this pushbutton 
is enabled.  

 
 

                   Enabled Apply Now button 
 

q  2.4.1.1 Click on  Apply Now (if applicable) – A busy cursor appears on the screen and the 
status bar will indicate that changes to parameters in the Settings (or similar) window are 
being sent to device. 



 
 

q  2.4.1a Load New (if applicable) – In the Settings, Control or similar window(s)  this pushbutton 
is enabled.  

 
 
 
 

                              Enabled Load New button 
 
 

q  2.4.2 Reset (if applicable) – In the Settings, Control or similar window(s) this pushbutton is 
enabled. 

 
                      Enabled Reset button 

 
q  2.4.2.1 Click on  Reset (if applicable) – A busy cursor appears on the screen and the status bar 

will indicate that a reset command is being sent to device.  
 

q  2.4.3 Switch (if applicable) – In the Settings, Control or similar window(s) this switch is enabled 
(i.e. not grayed out and may be Off).      

 
Enabled Switch 

 
q  2.4.3.1 Click  switch (if applicable) – It changes from up (On) to down (Off) or vice-versa.  In 

some instances, a busy cursor appears on the screen and the status bar will indicate that an 
on/off command is bei ng sent to device. 

 
q  2.4.4 Edit box (if applicable) – In the Settings, Control or similar window(s) this control is 

enabled unless it is dependent on another selection.  

 
Edit box 

 
q  2.4.4.1 Spin (Up/down) control (if applicable)  – Used with some edit boxes, this control is 

enabled with its associated edit box.  

 
Spin control 

 
q  2.4.4.1.1 When the up-arrow portion of the spin control is clicked the parameter in the 

associated edit box increments. To change the digit incrementing, highlight the digit and 
click the left mouse button. 

 
q  2.4.4.1.2 When the down-arrow portion of the spin control is clicked the parameter in the 

associated edit box decrements. To change the digit decrementing, highlight the digit and 
click the left mouse button. 

 
q  2.4.5. Radio buttons (if applicable) – In the Settings, Control or similar window(s) these controls 

are enabled unless it is dependent on another selection.  
 

Load New 



 
Radio button group 

 
q  2.4.5.1 When a radio button is selected/clicked, the other radio buttons in that group are de -

selected. 
 

q  2.4.6 Check boxes (if applicable) – In the Settings, Control or similar window(s) this control is 
enabled unless it is dependent on another selection.  

 
Check box 

 
q  2.4.7 Combo box (if applicable) – In the Settings, Control or similar window(s) this control is 

enabled unless it is dependent on another selection.  

 
Combo box 

 
q  2.4.7.1 Click on down-arrow and the combo box should open with a selectable list.  The user 

should not be able to enter data in the box:  

 
Open Combo box 

 
Note: In general, the use r should not be able to type data into a combo box. 

 
q  2.4.8 Keyboard control  – Use the Tab key to change control selection in the Settings, Control or 

similar window(s).  Selections should change in a general top -to-bottom, left-to-right pattern.  
 

q  2.4.9 Status window(s) parameters may update/change periodically.  If not now, resize the Status 
window so that all the parameters are visible.  Then resize the Settings, Control or similar 
window(s) and change a parameter that is also displayed in the Status window.  Click the Apply 
Now button and it should change in the Status window. 

 
q  2.4.10 Status light  (if applicable) – In the Status, Control or similar window(s) this is green or 

red: 
 

 
Status Lights 

 
q  2.5.0 The following File option is among those available:  Save 
 

q  2.5.1 Save – Make a change to one of the parameters in the Settings (or similar) window.  Choose 
Save.  User will be prompted to save file to a new name in a SaveAs dialog box. 

 
q  2.5.1.1 Click on  Cancel. 

 
q  2.6.0 The following File option is among those available: Close. 
 

q  2.6.1 Close – Closes open file and, in this mode, also terminates application. User may be asked to 
save file (see above). 

 
q  2.7.0 Repeat step 2.1.0. 



 
q  2.8.0 The following tool button is among those available: Save As. 
 

q  2.8.1 Save As – Make a change to one of the parameters in the Settings (or similar) window and 
make a note of that change.  

q  2.8.2 Click on Save As tool button. 

 
Save As tool button 

 
Parameter: _______________________  Changed to: _______________________ 
 

q  2.8.2.1 Enter “Test” for file name in window and click Save. 
 

q  2.8.1.1 If message asks to overwrite an existing file, answer Yes. 
 
q  2.9.0 The following File option is among those available: Exit. 
 

q  2.9.1 Choose Exit – Terminates application.  User may be asked to save file (s ee above). 
 

q  2.10.0 Check if parameter was actually saved.  Repeat step 1.1.0 (Local Edit).  
 

q  2.10.1 Repeat step 1.10.1 (Open a saved file.).   
 

q  2.10.2 Check parameter changed in step 2.8.1 (Save As) and make sure it is what was saved.   
 
q  2.11.1 Exit application.  Repeat step 2.9.1. 
 
Note: The GUI has now been completely checked in Local Control.  This concludes the procedure.  
 

 
 

 
 


